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Chamber Control  
 
From the System menu, select Chamber Control. 
 

 
 

Once the chamber control panel opens, ensure that there are no errors listed in 
the status box. 
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Selecting a chamber: 
 
The box titled “Select Chamber” allows you to switch between multiple 
chambers that are connected to the network. 
 
Chamber Configuration: 
 
To configure all chambers connected to the network select “Configuration” from 
the “Edit” menu. 
 

 
 

A window will appear that shows the current configuration of networked 
chambers. 
 

Status 
box 
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This window allows modification of the assigned chamber name, the IP address 
of the controller, and selection of the chamber model (vibration or thermal only).  
The IP address seen here needs to match the address setup in the CTI 
controller for proper operation.  See the SCADA install manual for instructions 
on how to set the CTI controller address. 
 
 
Viewing data: 
 
The graph in the center shows current chamber data.  If the graph is blank, 
check the “Comm Status” light in the upper right corner.  If this light is red, 
check the serial connection from the chamber to the PC. 
 
The graph settings change be changed by clicking the “Graph settings” button 
located below the graph itself.  The time span setting controls how many 
minutes worth of data are shown at any one time (x-axis range).  The Update 
time changes the number of seconds between graph updates.  Chart 
recommends a value of 5 seconds to ease computer and communication 
resources.  Both of these fields can be set by clicking the up/down arrow next 
to the value, or by clicking on the value and manually entering a number.  You 
can set the background color and grid color by clicking on the box showing the 
current color and selecting a new one. 
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Just to the left of the “Graph settings” button is the “Outputs” button.  This 
button brings up a window that will show the current heating, cooling, and 
vibration output levels. 
 

 
 

There is a legend located to the right of the graph.  Clicking on any legend entry 
opens a menu that allows the user to change color, axis, plot, and line options 
for that entry. 
 

 
 
Below the legend is a box labeled test name.  When a profile is being run this 
box shows the name of the file where data is being logged.  Data logged from the 
chamber is normally found in the “historical data” folder.  The file name and 
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data logging settings can be changed in the “historical setup” menu.  See 
“Collecting Data” section below for further details. 
 

 
 
Manual Mode Operation: 
 
On the control screen there is a box labeled “Chamber Mode” which shows the 
current chamber mode and has a button labeled “Change Mode”.  If the box 
shows “AUTO”, click the change mode button to go into manual mode.  The 
manual mode works exactly the same as it does on the touch screen.  It allows 
you to turn on/off events and change set points. 
 

 
 
Changing set points: 
The set point values are located in the “Present values” box located to the right 
of the graph.  This box shows the current chamber values and has two boxes 
labeled “Temp Setpt” and “Vibration Setpt”.  To change the value, click inside 
the corresponding box and type in the new value. 
 

 
 

To the left of the graph is a drop down box labeled “Control the”.  The drop 
down box has either “part temp” or “air temp” to choose from.  To change 
between part temp and air temp click on the box and select desired option.  
This determines which thermocouple (part or air) the chamber controls the set 
point to. 
 

 
 

 
Controlling events: 
 
The “Event control” box located in the lower right corner of the screen allows 
you to turn on/off chamber events. 

Click here to 
switch to manual 
mode 
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The top three buttons in this box control the heating, cooling, and vibration 
events.  To turn an event on, first you need to click the green box next to the 
event name.  Once the green button is illuminated the On/off box at the bottom 
will become active for that event.  To start the chamber controlling to the 
temp/vibe set point found in the “Present values” box, click the “Off” button to 
toggle the event on. 
 
The bottom portion of the event control box has buttons to control fans, 
nitrogen purge, air purge, and auxiliary events.  These events are turned on/off 
by clicking the green box next to the event name.  When the event is on, the 
green box will be illuminated. 
 

 
Automatic mode operation: 
 
With the chamber mode set to “AUTO” the profile options to the left of the graph 
become active. 
 

 
 
Running a profile: 
 
Clicking the “Select profile” box shows the current list of profiles that can be 
run.  Once a profile is selected it will show up in the “Current profile” box to the 
left of the graph. 
 
The “Start mode” box shows options for starting the profile. 

• On command: starts the profile when the user presses the start button 

Illuminated 
lights 
represent 
currently 
running events 
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• Delay start: allows the user to delay the start of the profile.  When this 
option is selected boxes open up below to allow the user to enter the 
desired delay time. 

• Remote start: allows the user to supply an input that triggers the start of 
the profile (see CTI manual for further reference) 

• At specified time: allows the user to enter the time which the profile will 
begin.  When this option is selected boxes open up below to allow the 
user to enter the desired start time/date. 

 
Once the desired start mode is set and a profile is selected, the Start button in 
the “chamber mode” box will become active.  To start the profile, click the start 
button.  To stop a profile during operation, click the stop button. 
  

 
 

The lower left corner of the screen shows profile time data. 
 

 
 

• Step time required: shows the length of the current step 
• Step time elapsed: shows how long the current step has been running 
• Step number: shows which step of the profile is currently running 
• Step skip: allows skipping of the current step 
• Profile time required: shows the length of the entire profile 
• Profile time elapsed: shows how long the current profile has been 

running 
 

Profile limits: 
 
The profile limits box allows the user to control maximum and minimum limits 
during the profile to ensure safe operation. 
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Clicking on the numeric value next to each limit allows the user to type in a 
value for that limit.  The dropdown box next to the value determines what the 
chamber will do if the limit is reached. 
 

• Disable Output: this option turns off the event which caused the alarm 
(example: if air temp hi is set to 100C and the temperature reaches 
101C, the chamber will turn off the heating event) 

• Do Nothing: the profile continues without interruption 
• Go to 20C: the chamber controls the temperature to 20C and stops 
• Shutdown Chamber: the chamber shuts down 

 
Downloading Profiles (from PC to PLC) 
 
The downloading utility is used to transfer pre-defined test profiles from the PC 
to the PLC.  These profiles must be saved on the PC in order to download them 
into the PLC.  There must also be an active Ethernet connection between the PC 
and the PLC (standard part of the SCADA package).  The following procedure 
should be used to download profiles from the PC to the PLC: 
 
1. From the System menu, select Download Profiles. 
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2. Verify there are not any error messages in the “Status” window. 
 

 
 
3. The screen will show a list of profile names that are currently saved in the 

current directory.  If the profile name of interest is not shown in the 
“Available Profiles” window, then it is not saved in the current directory. 

 
 

Check for 
errors here. 
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4. Identify the profile that is to be downloaded to the PLC. 
5. Select the profile by double-clicking on its name. 

• Notice that when the profile is selected (by double-clicking its name), the 
name will appear in the “Profile Selected” window on the right. 

 

 
 
6. Continue selecting profiles by double-clicking names until all profiles that 

are to be transferred appear in the “Profiles Selected” window. 

All profiles that 
are stored in the 
current directory 
on the PC will 
appear in this 
window. 

Double-click 
the profile 
name here. 

Any profiles 
that have 
been double-
clicked will 
appear in this 
window. 
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7. If a profile is accidentally selected, it can be removed from the list by double-
clicking the name in the “Profiles Selected” window, just the opposite of how 
it was added.  

8. When all profiles are selected, click the “Download Selected Profiles” button. 
 

 
 
9. Watch the “Status” window for update messages. If there are any errors, 

they will appear here. 
• The downloading process should not take extremely long periods of time 

unless many profiles are being downloaded, or the profiles are 
exceptionally long.  Typically, profiles require just a few seconds per 
profile for downloading. 

10. A window will appear notifying the user when the download is complete. 
 
 
Uploading Profiles (from PLC to PC) 
 
The uploading utility can be used to transfer any profiles that are stored in the 
PLC’s memory to the PC.  Once the profiles are on the PC, they can be edited, 
viewed, backed-up for future use, or downloaded to any other chamber. There 
must also be an active Ethernet connection between the PC and the PLC.  The 
following procedure should be used to upload profiles from the PLC to the PC: 
 
1. From the System menu, select Upload Profiles. 
 

Clicking this button 
will download the 
profiles “Test” to the 
PLC. 



REV B   14 of 34 
www.chartchambers.com 

 
 
2. Verify there are not any error messages in the “Status” window. 
 

 
 
3. The screen will show a list of profile names that are currently saved in the 

PLC memory.  If the profile name of interest is not shown in the “Available 
Profiles” window, then it is not saved in the PLC memory. 

 

Check for 
errors here. 
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4. Identify the profile that is to be uploaded to the PC. 
5. Select the profile by double-clicking on its name. 

• Notice that when the profile is selected (by double-clicking its name), the 
name will appear in the “Selected Profiles” window on the right. 

 

 
 
6. Continue selecting profiles by double-clicking names until all profiles that 

are to be transferred appear in the “Selected Profiles” window. 
7. If a profile is accidentally selected, it can be removed from the list by double-

clicking the name in the “Selected Profiles” window. 
8. When all profiles are selected, click the “Upload Selected Profiles” button. 
 

Profiles currently 
saved in the PLC 
memory will 
appear in this 
window. 

Similar to 
downloading profiles, 
as the profile name 
is double-clicked in 
this window, the 
name will appear in 
“Selected Profiles” 
window on the right. 
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9. Watch the “Status” window for update messages. If there are any errors, 

they will appear here. 
• The uploading process should not take extremely long periods of time 

unless many profiles are being uploaded, or the profiles are exceptionally 
long.  Typically, profiles require just a few seconds per profile for 
uploading. 

10. A window will appear notifying the user when the upload is complete. 
 
 

Creating Custom Trend Charts 
 
Custom trend charts can be created to develop a trend chart, which shows any 
combination of data the user would like to look at simultaneously.  This allows 
the user to “filter out” data that is not of particular interest for this test, or to 
combine various data types (temperature and vibration) in any arrangement. 
 
Use the following procedure to create a custom trend chart: 
 
1. Select Custom Trend from the Trends Menu. 
 

Left-clicking this 
button will upload any 
profiles shown in the 
“Selected Profiles” 
window from the PLC 
to the PC. 
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2. Select the data to be viewed on the chart by clicking the “Select Tags” 

button. 
 

 
 
3. Select the group to modify the data points on. 

• The custom trend chart can have up to four groups of data defined at 
any one time.  This allows the user to quickly look at one group of data 
for a particular test, then switch to a different group of data for another 
test. 

• For example, the groups could be configured such that: 
• GROUP 1 is temperature data 
• GROUP 2 is all vibration data 
• GROUP 3 is three temperatures and two vibration levels 
• GROUP 4 is three temperatures and three vibration levels 

 

Click to configure 
the data on the 
trend chart. 
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4. Select the data that is to be viewed from the list.  Double click the name of 

the data you want to view in the “Available Tags” window to add that tag to 
the currently selected plot group. 
• Some of the data available are: 

• AirTemp – The temperature as measured by the thermocouple located 
in the chamber’s plenum. 

• PartTemp – The temperature as measured by the thermocouple 
located in the chamber’s workspace. 

• TempSetpt – The temperature set point of the chamber.  If the 
chamber does not currently have a temperature set point, it will plot a 
value of zero. 

• VibrationLevel – The level of Grms measured by the control 
accelerometer. 

• VibrationSetpt – The vibration set point of the chamber.  If the 
chamber does not currently have a vibration set point, it will plot a 
value of zero. 

5. To remove unwanted tags from a plot group simply double click its name in 
the plot group window. 

6. When a group is defined, configure the any of the other four groups as 
desired by changing the plot group from the “Select Tag Group” dropdown. 

7. The groups are saved automatically as they are changed.  When complete, 
select the plot group you wish to view and hit the Exit button to return to 
the custom trend window. 

 

The Custom Trend Screen 
 
The custom trend screen was created to give users the flexibility to look at any 
collection of data together in groups, regardless of the data type (temperatures, 
vibration levels, set points, etc.).  Once all of the data has been configured (see 
Creating Custom Trend Charts section for details), the look of the trend chart 
can be customized as needed. 
 

Four groups of 
data can be 
configured 
independently. 
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Changing the Trend Chart Background or Grid Color 
The main background color or grid color of the trend chart can be changed to 
any color.  This can be done by the following procedure: 
 
1. Click on the “Graph Settings” button. 
 

 
 
2. Clicking on the colored square representing the current background or grid 

color will bring up the color selection window. 

 
 
To select a color move the cursor over the spectrum and click when the desired 
color is shown in the lower left corner.  A recently used color can also be 
selected by clicking it from the “History” list of colors. 
 
Changing the Trace Line Properties 
The properties of the individual trace lines can also be changed on the Custom 
Trend Chart.  This is done by clicking on the line to be changed in the right 
hand legend. 
 

Click to define 
the chart 
settings. 

Use any of 
these the 
spectrum to 
choose a 
color 



REV B   20 of 34 
www.chartchambers.com 

 
 
After clicking on the trace line of interest, a menu of properties that can be 
configured will appear.  Select the property and define it as needed.  Continue 
doing this for any and all trace lines to make the chart most appealing. 
 
Changing Custom Trend Chart Title 
The Custom Trend Chart can be further customized to make the data appear 
just as needed.  The title of the chart can be changed by clicking and dragging 
over the title to highlight it.  Once it’s highlighted, a new name can be typed in.  
When the new title is entered, do not hit the enter key!  After the new title has 
been typed in, click somewhere on the chart to leave the field and have the new 
name take place.  The title that was entered will become the new default title 
automatically. 
 
Changing Custom Trend Chart Scales 
The “Y-axis” scale of the Custom Trend Chart can be changed in two different 
ways.  The first way is to use the auto-scale feature.  With auto-scale turned on, 
the Y-axis will constantly update itself so that it fully shows all of the data.  For 
example, if the temperature suddenly goes up to 100°C, the Y-axis will 
automatically make its maximum value something larger than 100, maybe 110 
or 120 so that the new data can be clearly seen.  The auto-scale feature will 
work in the same way on the minimum value.  The auto-scale feature is turned 
on/off from the graph settings window: 
 

Clicking on the 
green line for 
AirTemp will 
bring up this 
menu of 
properties that 
can be defined for 
that trace line. 

Digital 
reading of 
current values 
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If the auto-scale feature is not used, the minimum and maximum Y-axis values 
can be changed by clicking and dragging over the values on the graph to 
highlight them, then typing in a new value.       
 
The X-axis (time) scale can be changed in the graph settings window.  This 
value represents how many minutes will be shown on the full axis.  In the 
following picture, the “Time Span” is set to fifteen minutes.  The minimum time 
data (on the left of the axis) is 9:49, and the maximum time data (on the right of 
the axis) is 10:04, which represents fifteen minutes. 
 

 
 
The graph update time is also set in the graph settings window.  Chart 
recommends a value of 5 seconds to ease computer and communication 
resources.

Check this 
box to turn 
on Y axis 
autoscaling 
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Creating/Editing Profiles 
 
The PC can be used to create new or edit any existing profiles much the same 
way as the touch-screen PLC.  For details on the operation of various functions, 
refer to the manual for the CTI controller.  To create a new profile: 
 
1. Select New Profile from the File menu. 
 

 
 
2. Start defining the profile by selecting the “Step Type” for the first step.  The 

list of available step types is shown when the down arrow to the right of the 
box is clicked. 
• Note that when the first step type is defined, the step numbers one 

through five automatically fill in place. 
• Note that the next undefined step is automatically defined as an “End” 

step. 
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3. Continue defining all of the parameters across the row for that step. 

• Note that as set points are entered, lines will be drawn on the chart to 
visually represent the profile as it is created.  This can help the user 
notice obvious data entry errors before running the chamber. 

 

 
 
4. Define the state of the Events for that step by clicking the buttons between 

ON and OFF. 
• Be sure to note the correct step number is being modified.  The step 

numbers that are shown in the top should match those shown in the 
Events section.  For example, if step number three is being defined, be 
sure the Events being defined are also on the row for Event number 
three. 

Enter all 
values as 
needed for the 
step. 
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5. If the chamber was ordered with the additional discrete output relays, they 

can be defined for each step.  Click the “Slot 5 Outputs” button to access the 
additional outputs. 

 

 
 

 

Define the state of 
Events for the 
appropriate step 
number.  Care should 
be taken to ensure 
the Events are being 
defined for the correct 
step number. 

Click this button to 
define the additional 
discrete outputs. 

Define the state of 
the additional 
outputs. Pay 
attention to what 
step number is 
being defined! 

When the outputs 
are defined, click 
the “Close” button 
to return to the 
profile definition 
page. 



REV B   25 of 34 
www.chartchambers.com 

 
6. Continue by selecting the “Step Type” for the second step. 
 

 
 
7. Continue defining steps and Events until the profile is completely defined. 
8. If more than five steps are needed, additional steps can be shown by clicking 

the down-arrow next to the top step number.  Then, select one of the 
numbers on the list.  The number selected will now becomes the top step 
number and the following steps will fill in automatically. 
• Note that the step numbers for the Events will update automatically also. 
• Note that the step numbers for the “Slot 5 Outputs” will update 

automatically also. 
 

    
 
9. Save the profile by one of the following methods: 

• If it’s the first time the profile is saved, select Save As from the File 
menu to give the profile a name. 

• If the profile has already been saved, and the profile name is to remain 
the same, select Save from the File menu. 

• If the profile has been saved previously, but this version is to be saved 
under a different name, select Save As from the File menu. 
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Editing an Existing Profile 
The software can also be used to make modifications to existing profiles.  Once 
these modifications have been made, the profile can either be saved under the 
original name, or saved under a new name.  To edit an existing profile: 
 
1. Open the existing profile by selecting Open Profile from the File menu. 
 

 
 
2. Select the profile name from the list by double-clicking the name. 
• Note that only profiles stored in the directory indicated in the window will 

appear in the list.  If the profile is stored in another directory navigate to 
that directory to open. 

• Profiles that were created on the touch-screen of the CTI, and have not been 
uploaded to the PC, will not appear in the list. 

 

 
 
3. When the profile has been pulled up on the screen, modify any portions of 

any steps as needed. 
4. Save the profile. 

• Saving the profile with the same name will cause the computer to over-
write the original version of the profile. 

• If the original version of the profile should still be saved, give the new 
version of the profile a new name when saving by using “Save as”. 

 
Profile Validation 
While creating the profile, it is possible to do a profile validation check.  The 
software has certain criteria that it knows must be defined in order for the 
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profile to run successfully on the chamber.  Doing a validation check will tell 
the user if any of these fundamental rules have been broken.  The software does 
a validation check automatically when the profile is saved, but it is also possible 
to do one at any time of the profile creation process by selecting Validate 
Profile from the File menu. 
 
If the software detects an error in the profile, it will give the user a message on 
the screen describing the error, and inform which step has the error.  When 
this happens, go to that step and correct the error.  When the error has been 
corrected, try validating or saving the profile again.  If there is another error, the 
software will again flash a new message.  If the profile passes the validation 
check invoked by trying to save the profile, the profile will be saved. 
 

 
 
In the above example, an error was found in step #1 because no dwell time was 
entered for a dwell step. 
 

Collecting Data 
 
The software can be used to create data files for future examination.  These 
data files will be delimited data files that can be opened in any common 
spreadsheet application.  The following procedure should be used to set up a 
data file: 
 
1. Select Historical Setup from the Historical Menu. 
 

Which step 
number had 
the error. 

Brief 
description 
of the error. 
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2. Assign a data file test name by clicking in the box and typing a name. 

• The data file will be saved as a file with a name, which begins with what 
is typed in this box, and ends with a time/date stamp. 

 

 
 
3. Define the time interval (in seconds) between data samples. 
 

Enter a text 
name here. 
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4. Select the data (“tags”) to be logged for this test by double clicking on the 

name in the “Select Tags to View” window on the left. 
• When the tag has been selected, its name will appear in the “Selected 

Tags” window as seen below. 
 

 
 

 
 
5. If a tag is accidentally selected, it can be removed from the list be double-

clicking its name in the “Selected Tags” window. 

Define the logging 
interval between 
data samples by 
either clicking on 
the scroll arrows, or 
entering a number 
in the box. 
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6. Unless this setup is changed, all future tests will log the same data tags at 

the same rate, with the same text name for a file name.  The data files will 
be distinguishable by the time/date stamp in the file name. 

7. The data files will be stored in the C:\Program Files\National 
Instruments\LabVIEW DSC Run-Time System 7.1\data directory on the 
hard drive. 

 

Reviewing Data 
 
Data already stored in the database can be reviewed or exported at any time 
through the historical data viewer. 
1. Select “Historical Trend Viewer” from the historical menu. 
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2. A window containing a list of all the data files will open.  From this window 
select the set of data you wish to view. 

 

 
 

3. A window will open that shows the properties of the saved data.  Selected 
tags, start time,  and stop time is shown in this window. 
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4. Click the “Display” tab in the lower left corner of that window to view the 
data graphically. 

 
 

5. Right-clicking on the graph area will bring up a menu containing many 
options about the graph.  
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• “Show legend” will open a legend on the right to show the color of 

each data channel.  Clicking the colored box next to the name will 
allow you to change the color of that variable on the plot. 

• “Autoscale Y” allows you to turn on/off the autoscaling feature for the 
Y-axis. 

 
6. Clicking on the time will bring up a window to set the total amount of time 

shown on the plot. 

 
 

Exporting Data 
 
The historical trend viewer allows you to export anywhere from a short segment 
of the data to the entire file for use in any spreadsheet program. 

1. To export data click the “Export to Text” button.  The “View Data Set 
Run” button is used to view data that has been logged for a pre-defined 
group of tags.  Since tags are already selected from the Historical Setup 
window this option is unneeded.  The “Export to DIAdem” button is used 
to export data to the National Instruments DIAdem data analysis 
package.  This package is not needed with the SCADA software and is 
therefore not used. 

 

Click here to 
open the 
date/time range 
window 

Right click on 
the legend to 
add/remove 
tags, rename, or 
change plot 
color 
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2. A window is opened to specify the exact data to be exported. 
 

 
 

• “Start time” is the desired beginning time of data to be exported.  
Clicking the arrow next to the current selection can change this 
value. 

• “End time” is the desired ending time of data to be exported.  
Clicking the arrow next to the current selection can change this 
value. 

• The “Field Delimiter” dropdown allows you to select how the 
output file will be delimited. 

• The “Output File” dropdown allows you to set where the file will be 
created.  Click the folder icon to the right to browse your entire 
system. 

 
3. Once the desired data and options are selected simply press the “Start” 

button to export the data to the selected file.  From there you may open 
that piece of data with a spreadsheet program of your choosing. 

 
Export data from manual mode operation: 
If the chamber is running in manual mode and you want to export a piece of 
data, simply open the historical viewer from the “Historical” menu and open the 
most recent set of data.  Pressing the red/green stoplight button in the upper 
left will switch to live mode.  This will show the current chamber data and at 
any time you can export this data using the “export to text” button. 

Export to 
Text button 


